SpecView

Quick Start Guide

Build 7xx

http://www.specview.com

February 11, 2002
DISCLAIMER

SpecView software communicates with industrial instrumentation and it displays and stores the information it receives. It is always possible that the data being displayed, stored or adjusted is not as expected. ERRORS IN THE DATABASE OR ELSEWHERE MEAN THAT YOU COULD BE READING OR ADJUSTING SOMETHING OTHER THAN YOU EXPECT!

Safety devices must ALWAYS be used so that safe operation of equipment is assured even if incorrect data is read by or sent from SpecView.

SpecView itself MUST NOT BE USED IN ANY WAY AS A SAFETY DEVICE!

SpecView will not be responsible for any loss or damage caused by incorrect use or operation, even if caused by errors in programs supplied by SpecView Corporation.

Warranties & Trademarks

This document is for information only and is subject to change without prior notice.
SpecView is a registered trademark of SpecView Corporation
Windows is a trademark of Microsoft Corporation.
All other products and brand names are trademarks of their respective companies.

Copyright © 1995-2002 by SpecView Corporation. All Rights Reserved.

This document was produced using the HelpBreeze Document Wizard.
HelpBreeze™ is a trademark of Solutionsoft
Quick Start

NOTE: Press the F1 key at any time for help
This quick start guide covers the installation and initial configuration of SpecView.

Once all the steps below have been followed, your screen should look similar to this:

The steps are as follows:
Installing SpecView
Starting SpecView (see page 4)
If you have no instrument currently connected to your computer then follow:
   Manual Configuration (see page 4)
or, if you do have an instrument(s) connected, then follow:
   Automatically detecting instruments and displaying Instrument Views (see page 7)

Then continuing:
Adding a variable to a Graphical Display Window (GDW) (see page 9)
Drawing Trend charts (see page 12)
Defining a second GDW (see page 14)
Adding buttons to switch between GDWs (see page 14)
Adding a Bar chart to a GDW (see page 16)
Seeing how it works in Runtime Mode (see page 17)

NOTE: SpecView’s name for each screen is a GDW (Graphical Display Window)
Each GDW is saved as a file on disk, much like a Word document.
Starting SpecView

Once SpecView is installed, double-click the SpecView icon, or click Start and run from the Programs menu. The Configurations Found dialog box will be displayed.

If you have an instrument connected then go to Automatically detect instruments (see page 7) below.

Alternatively, if you have no instrument connected you can still configure SpecView by clicking the New Manual Configuration button and then going to Manual Configuration (see page 4).

Manual Configuration

If you have no instrument connected clicking on New Manual Configuration will display the Input Required dialog box.

Enter a name for the configuration. SpecView will create a subfolder in the SpecView folder (normally C:\SV32, unless you specified a different folder intentionally when installing SpecView, although this is not recommended) with this name, so the name you enter should follow the Windows file naming rules and should not be too long.

When you have entered a name for the configuration and clicked OK this will immediately bring you into Configuration Mode displaying a blank Graphical Display Window (GDW) grid.
Click the Variables List tool on the Toolbar to display this dialog box. At this stage the only item listed will be SpecView.

Click the **Show New** button, which will list the pre-defined instrument types:

Scroll down the list of available instruments to find the name of the instrument you intend to connect.

Click the ➕ symbol beside it to display the specific instrument types. Select the appropriate one, then click **Add Item**.
Enter the Port (for example COM1) and enter the Address. If in doubt about what to set the address to, just click **Address Help**, then click **Create**.

Enter the Baud Rate and Parity appropriate for the port and click **OK**. If in doubt about the values for these please consult your instrument manufacturer’s manual.

**NOTE:** A method of testing if the COM port that your instrument(s) are connected to is functioning correctly is to run HyperTerminal. This may already be installed, and can be run from the Programs - Accessories - Communications menu via the Start.
button. If HyperTerminal cannot connect to the COM port, then SpecView will also be unable to communicate with it.

The instrument has now been defined within SpecView so clicking Show Defined will now list it.

Select the name of the instrument in the list and click Add Item. The Instrument View will be displayed on the GDW.

This is now configured as if the instrument was already connected and you had clicked the Test Comms for New Config button to automatically detect the instrument. Therefore you can now skip the next section, and go straight to Configuration mode to by starting with Add a variable to the GDW (see page 9)

Automatically detect instruments and display instrument views

Click the Test Comms for New Config button, to detect your instruments automatically. The Input Required dialog box is displayed.

Enter a name for the configuration. SpecView will create a subfolder in the SpecView folder with this name (normally under C:\SV32, unless you specified a different folder intentionally when installing SpecView, although this is not recommended), so the name you enter should follow the Windows file naming rules and should not be too long.

When you have entered a name for the configuration and clicked OK, the Ports and Protocols dialog box is displayed.
Port and Protocol
You will need to know which COM port(s) on your computer the instrument(s) are connected to and the names of the instruments. If in doubt about please consult your instrument manufacturer’s manual.

For the appropriate COM port(s) select the name(s) of the instrument(s) under Protocol. When you select a protocol for a COM port, a Help button is displayed on the same line. Click it for help on the driver selected.

If the default port settings do not match the settings for your instruments, click Settings... to set up the port.

BAUD Rate
Leave the BAUD Rate as “Auto”. However, changing the BAUD rate to the correct value will help SpecView detect your instrument(s) more quickly, as when set to “Auto” SpecView tests all baud rates for address 1, then checks addresses 2 and upwards at each BAUD Rate. If your instrument is, for example, set to 19,200 baud at address 3, it will take a long time for SpecView to detect it.

Start Scan
Click Start Scan SpecView will begin to scan the ports and determine what instrument(s) you have connected. As each instrument is found, Instrument Views (pictures of the instruments) will be displayed on the Graphical Display Window (GDW) behind the Ports and Protocols dialog box. When all your instruments have been detected for this port, click Skip to Next Port if there are further instruments connected to other COM ports, otherwise just click Stop. A window will be displayed to inform you that all channels have been scanned.

Click OK to continue and enter Configuration Mode.
The Configuration Mode screen will look something like that shown below.

However, if it is just showing a blank grid without the Instrument View, then Exit SpecView and repeat the steps above. If further problems occur please contact your SpecView supplier.

You have now created a GDW containing Instrument Views. The Instrument View(s) you see will depend on the kinds of instruments you have connected to your computer.

Now move the Instrument View to a different position on the GDW, by clicking and then dragging, to move it down the GDW a little way.

Click the Save tool on the Toolbar and then the Save button to save this GDW as “Specview.gdw” in the subfolder you defined earlier.

**NOTE: When using the Toolbar, move the pointer over a tool and the Tool Tip will tell you what it does.**

Add a variable to the GDW (see page 9)

**Add a variable to the GDW**

To add a variable to the GDW (Graphical Display Window) click the Variables List tool on the Toolbar to display a list of the instruments that SpecView has detected. The name SpecView also appears in the list as this represents a list of variables not associated with an instrument, but which may be useful.

Click the symbol next to an instrument name to see all the parameters
Double-click the variable you want to add to the GDW, for example, Input 1. The variable (XXX, which will be displayed as the numeric value of the variable in Runtime Mode) and its description (for example, MM8TC-, Input 1) are displayed in the top left hand corner of the GDW.

Use the Group tool (or press G) to group them together

and then use the mouse to drag them to where you would like them to be positioned on the GDW.

If you would like to change the name of the variable then it is best to do this from the Variables List dialog BEFORE putting the variable onto the GDW. This is done by selecting the variable and then clicking the Properties button.

If the Include Name box is un-checked in the Variables List dialog then the name of the variable will not be displayed on the GDW, just the value of the variable itself.

If you would like to change, for example, the font of the variable’s name, use the Ungroup tool (or press U) to ungroup the variable and its description, then double-click the description to display the Text Attributes dialog box.
Make the changes to it that you require, then click **OK** to close the dialog box.

**NOTE:** To change the default text font use the Text Font menu command from the Object menu.

Click the Save tool on the Toolbar and then **Save** to save this GDW again.

Click the Runtime tool on the Toolbar to enter Runtime Mode and start communicating with your instruments.

Values will be displayed on the Instrument Views and the variable you added to the GDW

If an Alarms dialog box is displayed this can just be closed.

**NOTE:** The immediately obvious differences between Configuration Mode and Runtime Mode are that Configuration Mode displays a grid across the screen (GDW). Although it is possible to disable the grid this is not recommended, as it helps with aligning items when positioning them on the screen (GDW). Variables in Configuration Mode are always displayed as XXX. There are also significant differences between the contents of the menus in the two modes and Configuration Mode also has a toolbar.
If you have manually configured the instrument(s) and they are not connected then XXX will appear where the values would be if they were connected.

Draw a Trend chart (see page 12)

Draw a trend chart

Go back to Configuration Mode by selecting Configuration Mode from the File menu.

Click the Draw Trend Chart toolbar tool and the cursor changes to:

Click and drag on the GDW to draw a rectangle. When you release the mouse button a Trend chart is drawn

and the Trend Chart Attributes dialog box is displayed:
This is used to choose what you want to display on the Trend chart and how you want it to look.

Time spans for the chart range from 1 minute to 28 days. When the Page Print box is checked the SpecView screen will be printed each time the chart is filled with new data.

Initially the Pens list is blank, click Add to add a Pen to the Trend chart, and open the variable list for the instrument from which you wish to display data by clicking the symbol if it is not already open.

Double-click the variable you want to put on the Trend chart, then set the scale for this Pen by entering values in the Min: and Max: boxes. If you want to change the label for the Pen, change the text in the Label: box.

**NOTE:** If the variable is NOT now listed under Pens, ensure that the variable was double-clicked in the list, not just single-clicked.

Change the color of the Pen by clicking the Color button

Click OK to close the Pen Attributes dialog box. Add some more pens to the chart, giving each a different color, then click OK to close the Trend Chart Attributes dialog box.

Click the Save tool to save this GDW again.
To subsequently edit the chart while in Configuration Mode, Double-Click anywhere on the chart.

Define a second GDW (see page 14)

Define a second GDW

You have already saved the first GDW (Graphical Display Window).

Now click the New GDW tool to get a new blank GDW.

Click the Trend Chart tool and draw a second chart. Any variables (see page 12) may be used, even the same ones as before.

Also, many types of variable can be plotted on a Trend chart, including Boolean (On/Off functions).

Click the Save tool and give this new GDW a name so it can be saved.

Add button to switch between GDWs (see page 14)

Add buttons to switch between GDWs

To put a button on the GDW click the Draw Buttons tool. Draw the button by clicking and dragging the mouse until the button is the size and shape you require.

Double-click the button to display the Button Attributes dialog box,
and change the text in the Caption: box to say, for example, “Return to first screen”.
Then from the Action: list, select GDW Control: Swap to another GDW, then select the name from the Swap To: list that you gave to the first GDW.

Click OK to close the Button Attributes dialog box, then click the Save tool to save this new GDW again.

Open the first GDW by either clicking the Open GDW tool and then selecting the name of the GDW from the list and clicking OK,
or by selecting the name of the GDW from the Window menu.

Click the Draw Buttons tool and draw a button on this GDW. As before, double-click this button and change its attributes. Change the caption to say, for example, “Go to second screen”.
From the Action: list, select GDW Control: Swap to another GDW, then select from the Swap To: list the name that you gave to the second GDW, click OK. Click the Save tool to save again.

Add a Bar chart (see page 16)
Add a Bar chart

Adding a Bar chart to a GDW is very similar to adding a Trend chart.

Click the Draw Bar Chart tool and the cursor changes to . Click and drag on the GDW to draw a rectangle as shown below. When you release the mouse button a Bar chart is drawn on the GDW and the Bar Chart Setup dialog box is displayed.

This is used to choose the variable you want to display on the Bar chart and the appearance of it. Select the variable you want to display from the variables list by clicking the symbol next to the name of the instrument, if it is not already open, and then double-clicking on the name of the variable.

**NOTE:** If the name of the variable is NOT now shown on the right hand side of the Bar Chart Setup dialog box, ensure that the variable was double-clicked in the list, not just single-clicked.
Orientation defines how the value is displayed within the bar chart; **Vertical** for up/down, **Horizontal** for left/right.

Enter a Top Value and a Bottom Value. You can choose the color of the bar, whether the bar grows from the bottom up, from the top down, or both up and down. And in the Scales section of the dialog box you can also choose whether to display a scale for the Bar chart and whether or not to show the value numerically within the bar.

Click the Save tool again.

*See how it works in Runtime Mode (see page 17)*

### See how it works in Runtime mode

Click the Enter Runtime tool to see how the configuration you have just set up working in Runtime Mode.

Your GDW screen should now look similar to this:

The Instrument View, variable, Trend chart and Bar chart on the first screen of the GDW will be displaying data.

Clicking on the button(s) shown within the Instrument View(s), in this example the **PAR** button, should perform similar actions to clicking on the respective buttons on the front of the actual instruments themselves.

Clicking on the value of the variable, in this case 19.7:

**MM8TC-1.Input 1: 19.7**
could if the variable was writeable allow this value to be changed. However, as the variable “Input 1” is not a writeable variable this is not possible in this example.

The Trend chart lines will initially be invisible. However, after a few moments the lines will start to be drawn.

Clicking on the [Setup] button in the top right-hand corner of the Trend chart allows you to modify the Trend chart attributes.

Clicking on the [Help] button in the bottom left-hand corner of the Trend chart will display help for the Trend chart attributes.

Clicking on any of the Pen labels along the top of the Trend chart switches the vertical scale to match the scale that you defined for that Pen.

Clicking on the Go to second screen button will switch to the other GDW which you defined, which may look similar to this:

[Image]

CONGRATULATIONS! You have just created your own custom multi-screen supervisory system in just a few minutes.

Now explore the Data Logging and (optional) Historical Replay features. Then you can go back into the Configuration mode and explore the custom graphics, Recipe and other features of SpecView.

Use the help system, by pressing the F1 key, to find out about SpecView’s advanced features.